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Defining Business Integration
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Integration

The efficient and flexible combination of resources
to optimize operations across and beyond the enterprise
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People Processes Information
» Portal — personalized information » Workflow management »~ Federation & data placement (replication,
> Collaboration technology > B2B connectivity ETL, caching)
» Adaptable workplace » Messaging infrastructure (EAI) » XML (store, query, webservices)
» Consistent rule-based experience across . o_Business transactions » Meta-data management
devices > Service-oriented architecture » Text Search and analytics

40% of people’s time is 40% of IT budgets may | 30-50% of design time is | 85% of information is
spent searching for be spent on integration copy management unstructured
relevant information

® for each $1 spent for a packaged application, customers spend $5 to $9 on the labor for integration !
(IBM Customer Surveys, 2001, 2002)

Can | create business value from my existing IT systems? D People, Process, Information
Can users react in real-time to the most recent information? } People, Information

Are business operations fully integrated for optimal efficiency? } Process, Information
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IBM Information Integration Vision

Any Data
» Multiple access paradigms

» Multiple integration disciplines

XQuery Content Search
Federate Transform Place Publish

Share 1 metadata and acceéss foundation

= e
i =i

Federated Replicated Event
Data Data Publishing

.

—

zSeries Il Offering :

. ! I 4 e o ' =] | ) 3 L= L i a3
© ) IB)VIsBrporation 2005 D 1B Sphere Information Integration - z/OS landscape




IBM Software Group | WebSphere Information Integration Software

Using Websphere Information Integrator as GRID Enabler
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= Leverage IT Infrastructure
= Accessing Information Federation

regardless of Database ederation
3 Centralization
- A

Management System and
WebSphere Information Integrator

Structure

Information Virtualization

s s %

File System / Storage Virtualization
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Federated Data Server
» WebSphere Information Integrator Classic Federation — z/OS Platforms

> WebSphere Information Integrator - LUW Platforms
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WebSphere Information Integrator Classic Federation for z/OS

= Typical Large IT Enterprise Environment

» Decades of heterogeneous technology investment :
60% of data resides on mainframe and is growing 20% per year

» Real-time access to mainframe—based data to remain competitive

» High performance and scalability are mandatory

= DB2 Information Integrator Classic Federation for z/OS

» Read/Write mainframe data sources using SQL through
standard ODBC, JDBC, CLI

» Native database connectors | WebSphere Information Integrator
leverage power of each Clasecc Federation for z/OS
database/file accessed

» Metadata-driven means:
* No mainframe programming

required
- Fastinstallation, configuration pg, ypg  vsams IMS/DLI Software AG  CA CA
& ease of maintenance for z/0S sequential Adabas Datacom IDMS
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WdebSphere Information Integratror (Zlassée Federation
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AIX, HP-UX, Solaris, JVM 1.2, Polrtal =] 'Il'ool Servlet Servlet

WidowsiNT; 2000, XP, |
2/0S, 0S/390 ODBC Client EJB —1

Z/0S
0S/390) ey —) ‘ e

adata
alog

"use]
; %;l r Data Data Data Data Data Data
— Connector Connector Connector Connector Connector Connector

Lopyhooks, DBDS, ...

..

DB2 UDB z/0S

DataMapper
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WebSphere and Il Classic Federation
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__ = Integrate mainframe data directly with
AEDsRteT Rppucsion = T Web applications, Portals, EAI
platforms

= Supports JDBC 2.1 Core APIs Plus
» Scrollable/Updatable ResultSets
» Commit — Rollback — AutoCommit - XA

» Stored Procedure to mainframe
programs
» Parameter Markers

» Metadata commands for tables,
WebSphere Information Integrator Co|umnS, keyS, procedureS,

Classcc Federation for z/OS

» Connection Pooling Support via
Relational Resource Adapter (RRA)

N » SQLBatch Operations
N » Statement commands e.g. re-execution
of prepared statements
DB2UDB VSAM & IMS/DLI Software AG CA CA
for z/0S sequential Adabas Datacom IDMS
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Integration in Action — European Catalog House
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Seamlessly share order processing data and algorithms between:
» Legacy call-center systems
» New e-commerce applications

» No mainframe skills required for e-commerce site development

Call-Center
Rep

cust@mem

Order
Plrocessing

Call-Center, st@merf

Shipzto
Date CGalc

Customer
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Integration in Action — Recreation Vehicle Manufacturer
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Provide accurate inventory and sales data to data warehouse
» Dynamically connect data warehouse tool with mainframe data

» Cut development time in half

» Accelerate product delivery with warehouse “pull” of new shipment data

Order N Credit
Processingivy Accurate

g Finventory information
s Management :
| T—

Bl Business }N
R llitelligence i

Sales

Marketlng

Federation
TCP/IP

gl Warehouse

Builders
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Integrating Enterprise Data

2/0S
DB

0
DB2 Il @lasece| D

Federation g

Packaged 4 =
apps Biological Data
And Algorithms
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| Integrated SQL View |

| DB2 Information Integrator

SQL, SQL/XML

Federation Engine

Wrappers and functions

IBM
Extended

Search

WWW, email,...

© ) IB)VIsBrporation 2005 TS ¢ WAL ' IBM WebSphere Information Integration - z/OS landscape




IBM Software Group | WebSphere Information Integration Software

Access Distributed Heterogeneous Data from CICS Applications
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Business Scenario

» Access all kinds of DB2 |l CICS/IMS Applications
Data Sources from legacy on z/0S
Applications
. _ _ Websphere Information Integrator
> Single Site Update, Multi Database configured as
Site Read DB2 z/OS CDB Location

> Distributed UOW with 2PC
support in plan for following
version of WebSphere |l

Distributed Hetero-
geneous Data Sources u
are accessed (read/write)

through DB2 Information
Integrator Nicknames

WebSphere
Information Integrator

- : 5 ko IRR ot ' - ; - OC
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Information and Process Integration with WebShpere

Business Scenario
» Enterprise Applications provide

APIs for Business
Object/Component Retrieval

Enterprise Business
Components can be mapped
into relational Format using
WebSphere components :

v" Information Integration

v Business Adapters

Business Objects can be joined
with other relational / non-
relational Information
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SQL, SQL/XML
AN D R

WebSphere

Information: Integrator

WebSphere Wrappers for Integrated
Business Integrator Business Objects

e

Enterprise Applications
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Federate or Replicate — That is the Question !!

1

1
-||l
Imn

Data Federation
» SQL Transparency
> Real-Time Access
» Global Optimization
> SQL Pushdown

DB2 Federated DB2 and Non-DB2
Database ' Databases

DB2 /I

DProp

Consolidated
Applications

» Data Movement
» Data Transformation
» Autonomy

Data Replication /

DB2 Target DB2 and Non-DB2
Databases

. , . | ko i .1 A\C
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Replicated Data
» SQL Replication
» Q Replication
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Why Replicate?

= Distribution / Consolidation

» Move data between central to branches,
branches to central, or both

» Federate or Replicate ?
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= Availability

» Scheduled outage, failover,
disaster recovery

- can use Hardware and/or Software

- where does the application need the data ?  * replication offers lower expense,

- does the data need to be real time ?
- what is the change volume ?

= Warehouse & Business Intelligence

» Move data to new platform/database,
transform data

» ETL or Replicate?
* latency needs
- change volume versus total volume

- complexity of transformation and/or
cleansing

= Mobile Workforce

» Occasionally connected
distribution/consolidation

©) IBIsBrporation 2005] = _: o :*" ' IBM WebSphere

In

faster restart, multi-purpose
» Hardware offers simplicity of setup

» Move query or reporting work
to a separate system

- other methods such as flash copy
also possible

» Peer to peer - split workload

 only possible through replication
* requires serious planning

and consideration
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SQL Replication Architecture

Trigger based

External application

© ) IBVKsBrporation 2005

\ Staging tables /
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Aal Implementation

» DB2 Data Propagator
» DB2 Il Replication Edition Nicknames
» IMS/DLI Data Propagator

= Actual Implementation Benefits
» Extremely flexible and resilient
» Very easy to set up transformations
» Scales well to reach multiple targets
» Homogeneous & Heterogeneous Sources

BM WebSphere Information Integration - z/OS landscape
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Sample SQL Replication Scenarios

SOURCE
A I Y
— CD

m

UCOPY UCOPY UCOPY

=
/N

Data Distribution (1:m)

T
e

Data Consolidation (n:1)

v
~ UCOPY  UCOPY

Transformation Multi-Tier Staging

= Subsets = Updateable Predicates
= SQL Transformations = Updateable Primary Keys
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DB2 Data Replication TO / FROM Federated SOURCES

SOURCE APPLY CONTROL

OURCE1 | CAPTURE CONTROL
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ONIRO Uuow
f ; DPro 3 \
L o e %E
ADMINISTRATION '
= " H \ l ’
o S
S |:> "we
. . r0000 (currently
e —— hetle.rog.eneoyz
Replication Replication replication wit
SaLrpleaton | TARGET
»>DB2 »Informix
Federated Sources & Targets >Oracle >Sybase

»>SQL/Server >Teradata (Target only)
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Why Create Another Replication Architecture?

= Performance

» GCombine high Throughput
with low Latency

= New Function

» Event Publishing
from DB2 and Classic Sources

= Capability

» Significantly improve multi-
directional Replication Support

= Manageability

» Reduce the number of
Replication Objects to be defined
and managed

» Ease the Definition Process with
new Replication Center Wizards
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Q Replication Architecture
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Websphere Information Integrator introduces new replication architecture
for delivering extremely low latency replication

> | Targ
a s Capture l

Log based

5
Stored
Procedures

Federation
Engine

WebSphere MQ

= Each message represents a transaction = Data Integrity
BT » Persistent messaging with
Highly parallel apply process WebsphereMQ

» Non dependent transactions

re-parallelized at the target » Detects missing messages

= Differentiated = Data transformation

conflict detection and resolution » Triggers on the target table
, » Stored Procedures called by Apply
= Integrated infrastructure at the row level
for replication and publishing » Publish Event to user application

= DB2 to DB2 today

©IBMKEBrporation 2005/ k" . SN e WebSphere Information Integration - z/OS landscape




IBM Software Group | WebSphere Information Integration Software

Q Replication — Defining Subsets or Filters

= Subset data
» Subset of rows through Q Capture predicate on subscription/publication
» Subset of columns through subscription/publication definition
» Signal (IGNORETRANS) defined to allow user selected transactions to be ignored
» Subscription/publication send options
« Change Only: Publish only columns that have changed vs all columns in the row
- All Changed Rows: Publish a row if any column changes (subscribed or not)

- Suppress Delete: Do not publish row deletes
- Before/After values: Publish before values as well as after values

= Predicate examples

» Based on values in the row data itself
WHERE :LOCATION ='EAST' AND :SALES > 100000

» Based on values in data in other tables
WHERE :LOCATION ='EAST' AND :SALES > (SELECT SUM (expense)
FROM STORES WHERE stores.deptno = :DEPTNO)

Y S B ol | ' ~ 0 5 - ) = o
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Sample Q-Replication Scenarios

- SOURCE
A B A N
2 AN
;ﬁﬁ@\

Data Distribution (1:some)
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Bi-directional
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Key Scenarios:

Low-Latency
Replication

Geographically
dispersed Applications
with distributed
Databases

Bi-directional
Replication with Conflict
Checking, Handling,
and Notification

Software-based Hot-
Standby

Cross DB2-Family
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Feeding Trade-History Database with Q-Replication

High-Speed Q-Replication .

Trade History

4— | ‘ Applications
)-Caplture Q) Apply

Trading
Applications

Trade
Processing Trade

Data History
Business Scenario Data m

> In many Online Environments OLTP Data is kept separately from = =
Query/History Data for better Performance of both Update and "
Query Applications

> This user has just made an Online Trade — he will keep hitting
Enter until he sees that the Trade is complete, in this Case
meaning it has been replicated to the Trade History Database

- s = * o IRR Sl . . : - AC
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High-Availability Solution built upon Q-Replication

-| Read/Write Applications
 —

Read Only Applications -

< -
L]

1

Q-Apply

W-Capture

Primary Database

Q Capture Q Apply

Secondary Database

Business Scenario

>

Y VY

Replication Processes and Subscriptions are defined in both Directions, but Data
mainly flows in one Direction at a Time

Recursion is stopped by Capture, which reads special logged Events created by Apply

Data at the Secondary System is transactionally consistent and is available for “read
only” Applications permanently

Procedures for Failover and Switchback will depend on which Options have been
selected for Conflict Detection
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Event Publishing
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Why Publish Data?

= Database to Application Messaging

» Drive downstream Applications or APIs based on the
Transactional Data of the changed Database Events
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= Event Notification
» Stream changed Data Information to Web Interfaces
» Stream only particular Events of Interest (filter Data)

= Data Warehouse / Business Intelligence
» Integrate captured Changed Data with an ETL Tool
» Perform complex Transformations with custom Logic
» Use a specific Transaction Format to update Target

= MQ provides guaranteed delivery
» Avoids the need for 2-Phase-Commit (2PC)
» Works even when the Target is not available

Y S B ol | ' ~ 0 5 - ) = o
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Publishing data events to facilitate business integration
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Capture database changes as XML messages
and publish them to WebSphere MQ

= Function = Usage

» Publish events to a message queue » Application to application
» XML self-describing format messaging

» Wizard-driven configuration » Event streaming
» Source for ETL tool

/ DB2 UDB
Log-based WebSphere
capture Business Integration
|
WSl
Capture
WebSphere MQ T
Application

WebSphere MQ User
Integrator Broker Application

© IBMESBrporation 2005, " at andscape
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Event Publishing - Publication Options
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* Format
» Only data from committed transactions is published
» Data is self describing with XML tags
» Row based = one row per message
» Transaction based = one transaction per message

= Row Content
» Subset by column
» Subset by predicate
» Changed column values only or all column values
» New data values only or include old values

\ =8 kWl ! . ‘ e
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Combining SQL and Q Replication with Event Publishing
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Log Reader 1

Capture Sch =N | [—
apture Schema ; » » f
17 Iz CD1 SQL Apply »
‘ carr | |
\\ T e T AR AE —_— h,

Q Capture
t

Log Reader 2 Schema

“CAP2”

User
Application

SQL Replication and Q Replication can co-exist
» Managed at source by using multiple capture schemas
» One Q Capture can handle both Publications and Subscriptions

© IBjIsBrporation 2005 h * .. % « WA, BNV >phere Information Integration - z/OS lanascape
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DB2 |l Event Publisher & Business Intelligence
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Feeding Changed Data to :
» Data Warehouse

» Datamart

» QOperational Data Store (ODS)

Optimize Resource Utilization

» Minimize Bandwidth Requirements

» Maximize Data Currency 1040101010111001010014301010001 10153 00101004 0101 0010101010}
WebSphere information-integrator

Event Pubpblishers-for:z/0OS

Complements with
WebSphere Il Federation

> Data feed using Event Publishers [:32 ?gg VSAM  IMS/DLI  CA-IDMS
or z

» Real-time extensions using Federation

\ =8 kWl ! . ‘ e
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DB2 |l Event Publisher & Business Integration

Data “Events” drive business integration
» Seamless integration with EAl via WebSphere MQ

Data used to drive EAIl workflow

» Inventory update hits threshold...
triggering restocking process

> Addition of new customer:
v’ Initiates welcome email

v Credit verification WebSphere

v Accounting updates
Vo

Cross-silo data synchronization
» Synchronize mainframe updates with:
v CRM
v ERP

v" HR, etc. DB2 UDB
for z/OS

© IBSBrporation 2005 M . A « ¥as ] WebSphere Information Integration - 2/
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m SEEBEYOND /
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«WebSphere Information-integrator
event Puplishers:-for z/0OS

=408 H

CA-IDMS
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Sample Application

= Near real-time cross-silo data synchronization
» Loosely coupled integration
» Minimizes development effort
» Simplifies maintenance

- e.g. New order data is automatically pushed to a CRM application
e.g- VSAM employee data updates are pushed to SAP payroll

Customer ¢ - on J—
Updates .1 4 WebSphere
| | wd” J BUSIness

Integrator
]
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Order Processing — Exploiting || Event Publishing
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WBI

Event Broker

Billing Request
Creation

-
-

grder
ntry | Order
Applications Processing
Data
Shipping Request
Creation

Business Scenario
> As new Orders are entered into the Order Entry System, the pertinent Data is
captured and published into a Queue

» The Websphere MQ Integrator Broker processes the queued Data

> A billing Transaction is created and queued in one System and a Shipping
Transaction is created and queued in another System

- s = * o IRR Sl . . : - AC
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Sample Application

= Event Notification
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» Receivable balances approaching credit limit pushed to a credit analyst
« Threshold is independent of order processing and accounting applications
- No “hard-hooks” in OLTP applications necessary

Orders,
Payments,
Returns,
etc.

©) |BMsBrporation 2005
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Why data events versus application events?
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= Integration is independent of the source applications

» Applications grow and evolve with
“minimal impact on the integration “

» Relatively straight forward to find data items
“ rather than every business rule “

» e.g.many applications change inventory
but the data values trigger re-stocking

» e.g. many transactions impact Claim status
changes to status value drives workflow

» e.g. order data is needed by a CRM
CRM has no dependence on ordering process

© IBMEsBrporation 2005/ " a ' IBM WebSphere Information Integration - z/OS landscape




‘ IBM Software Group | WebSphere Information Integration Software

Summary
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Using Classic || Event Publishing for Replication

-

>
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IMS/DLI
data is
updated

Data is Captured
near real time

o Stored procedure
I ﬂ generates DB2
@l I/U/D staiements

= |t is our direction to support replication of Classic data sources using the
highly parallel Q Apply of DB2 Il Replication.

= As an interim suggestion, SQL stored procedures can be used to apply the
data captured through the Il Classic Event Publisher

© IBjsirporation 2005 J* ' A : Sphere Information Integration - z/OS landscape
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Summary

= Information integration is a foundation for companies to build an On Demand
Operating Environment enabling them to align their IT infrastructure to
business priorities

= WebSphere Information Integrator provides access to diverse, distributed, and
real-time data as if it were a single source, no matter where it resides.

= WebSphere Information Integrator will help businesses
» Optimize IT investments given more choice in data access
» Improve productivity and application efficiency
» Enable greater return on existing assets

= Rely on IBM’s proven technology and support for open standards

3 S ko [Ny ~ 1 . . ' L o
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WebSphere Information Integrator Packaging and PIDs
Distributed (Linux, UNIX, Windows) Mainframe (IBM eServer zSeries)

WS Il Advanced Ed. Unlimited PID 5724-C74

WS Il Classic Federation for z/OS

PID 5697-182
WS Il Advanced Ed. V8.2

DB2 Il DataPropagator for z/OS

V8.2 (SQL Replication)

WS Il Standard Ed. PID 5655-160

WS I

Replication
Ed.

WS Il Event
Publisher Ed.
WS Il Classic Event Publisher

WS Il Developer Edition for IMS V8.2

WS Il Event Publisher

for DB2 UDB for z/OS V8.2 PID 5655-M36

WS Il Replication for z/OS V8.2 PID 5655-1.88
(SQL+Q Replication, Event Publishing)

PID 5655-M38

WS Il Classic Event Publisher
PID 5724-C74 PID 5655-M35
WS Il OmniFind Edition (same as for for VSAM V8.2
DB2 II)
« Processor-based pricing except for Developer Edition WS li Classic Event Publisher PID 5655-N56
which is priced by user for IDMS V8.2
* Priced Connectors to access non-IBM sources « Value Unit pricing Model
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